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Chapter 1 Precautions 
Always follow these safety instructions when setting up and using the visual presenter:

1. Do not place visual presenter in tilted position. 
2. Do not place the visual presenter on an unstable trolley, stand or table. 
3. Do not use the visual presenter near water or source of heat. 
4. Use attachments only as recommended. 
5. Use the type of power source indicated on the visual presenter. If you are not sure of 

the type of power available, consult your dealer or local electricity company for 
advice 

6. Place the visual presenter on a place that it can be unplugged easily. 
7. Always take the following precautions when handling the plug. Failure to do so may 

result in sparks or fire. 
 Ensure the plug is free of dust before inserting it into a socket. 
 Ensure that the plug is inserted into the socket securely. 

8. Do not overload wall sockets, extensions leads or multi-way plug boards as this may 
cause fire or electric shock. 

9. Do not place the visual presenter where the cord can be stepped on as this may 
result in fraying or damage to the lead or the plug. 

10. Unplug the projector from the wall socket before cleaning. Use a damp cloth for 
cleaning. Do not use liquid or aerosol cleaners. 

11. Do not block the slots and openings in the projector case. They provide ventilation 
and prevent the visual presenter from overheating. Do not place the visual presenter 
on a sofa, rug or other soft surface or in a built-in installation unless proper ventilation 
is provided. 

12. Never push objects of any kind through cabinet slots. Never allow liquid of any kind 
to spill into the visual presenter. 

13. Except as specifically instructed in this User Manual, do not attempt to operate this 
product by yourself. Opening or removing covers may expose you to dangerous 
voltages and other hazards. Refer all servicing to licensed service personnel. 

14. Unplug the visual presenter during thunderstorms or if it is not going to be used for 
an extended period, do not place the visual presenter or remote control on top of 
heat-emitting equipment or heated objects such as a car and etc. 
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15. Unplug the visual presenter from the wall outlet and refer serving to licensed 
service personnel when the following situations happen: 

 If the power cable or plug becomes damaged or frayed. 
 If liquid is spilled into it or the visual presenter has been exposed to rain or 

water. 
 

<Note> Using an incorrect battery type in the remote control may result in 
breakdown. Follow your country’s instructions on how to dispose of used 
batteries. 
 

 Safety Precautions 

Warning: To reduce the risk of fire or electric shock, do not expose this 
appliance to rain or moisture. 
 

This visual presenter has a 3-wire AC line Plug. This is a safety feature to ensure that the 

plug will fit into the power outlet. Do not try to disable this safety feature.  

If the visual presenter will not be used for a long period of time unplug it from the power 

outlet. 
 

                                        

Caution: To reduce the risk of electric shock. Do not remove cover (or back). No 
user-serviceable parts inside. Refer servicing to licensed service Personnel. 

 

This symbol indicates that 
this equipment may 
contain dangerous 
voltage which could 
cause electric shock. 

This symbol indicates that 
there are important operating 
and maintenance instructions 
in this User Manual with this 
unit. 

CAUTION 

RISK OF ELECTRIC SHOCK 

 
 FCC Warning 

NOTE: THE MANUFACTURER IS NOT RESPONSIBLE FOR ANY RADIO OR TV 

INTERFERENCE CAUSED BY UNAUTHORIZED MODIFICATIONS TO THIS 

EQUIPMENT.  SUCH MODIFICATIONS COULD VOID THE USER'S AUTHORITY TO 
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OPERATE THE EQUIPMENT. 

 

Note: This equipment has been tested and found to comply with the limits for a Class A or B 

digital device, pursuant to Part 15 of FCC Rules. These limits are designed to provide 

reasonable protection against harmful interference in a residential installation. This 

equipment generates uses and can radiate radio frequency energy and, if not installed and 

used in accordance with the instruction, may cause harmful interference to radio 

communications. However, there is no guarantee that interference will not occur in a 

particular installation. If this equipment does cause harmful interference to radio or 

television reception, which can be determined by turning the equipment off and on, the 

user is encouraged to try to correct the interference by one or more of the following 

measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

Notice: 

(1) A Unshielded-type power cord is required in order to meet FCC emission limits 

and also to prevent interference to the nearby radio and television reception. It is 

essential that only the supplied power cords by used.      

(2) Use only shielded cables to connect I/O devices to this equipment. 

(3) Changes or modifications not expressly approved by the party responsible for 

compliance could void the user’s authority to operate the equipment. 
 

 EN55022 (CE Radiation) Warning 

This product is intended for use in a commercial, industrial, or educational environment. It 

is not intended for residential use. 

 
This is a Class A product. In a domestic environment it may cause radio interference, in 
which case the user may be required to take adequate measures. The typical use is in a 
conference room, meeting room or auditorium. 
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Chapter 2 Package Content 
DC260 Quick Start Guide User Manual  

   

Base Installation 
Guide 

Remote Control Power Cord 

  

 

 
Appearance may vary with 

country/region. 
Software Bag VGA Cable USB Cable 

 
 

C-Video Cable Remote Control 
Holder 

Microscope Adaptor 

  
Padded Carry Bag 

(Optional) 
RS232 Adaptor  

(Optional) 
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Chapter 3 Product Overview 

 

8. Gooseneck 

7. AF button 

4. LED indicator
1. Lamp 
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3. Control panel 

9. Built-in icrophone 

2. Remote sensor 

 

5. Lens 

6. DIP switch 

(Bottom) 
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3.1 Relative position of the presenter and DC260 

 

 
 
 

DC260

Presenter 
Document 

3.2 Recommend distance 

About 470mm distance between camera and the desktop is recommended. 
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3.3 Incorrect use 
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Chapter 4 Installation and Connections 
4.1 System diagram 

 

TelevisionPC 

Monitor Projector

 

PC 

Microphone 

Speaker (or an 
amplifier before 
connecting to the 
speaker) 

SD Card LCD TV 
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4.2 Mounting the DC260 at desktop 
1. Please set up the DIP Switch settings first. Refer to Chapter 5 “DIP 

Switch Settings” in the DC260 user manual. 
2. Please refer to the Base Installation Guide for installation instructions 

for all parts. 
 

4.3 Connecting devices 

4.3.1 Step 1: Plugging in the power outlet

 
 

<Note> Appearance of power cord may vary with countries/regions. 
 
4.3.2 Step 2: Connecting with components

AC Outlet 

 Connecting to a projector or monitor 
 Use VGA cable to connect VGA OUT connector on DC260 to a 

projector or the VGA IN connector on a monitor. 

                 
 
 Connecting to a TV 
1. Use C-Video cable to connect TV. 
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2. Adjust DIP Switch Setting 

 NTSC: America, Taiwan, Panama, Philippine, Canada, Chile, Japan, Korea and 

Mexico 

  
 PAL: Country/region not listed above: 

 
<Note> You are unable to use the [Menu] / [Rotate] / [Half Page] / 
[Source] / [Record] / [Capture] / [Delete] / [PBP] / [Slide Show] 
functions in C-Video mode. 
<Note> VGA output is not supported once C-Video output enabled. 

 
3. Restart the DC260 

DIP Switch setting will not be available until restarting the DC260. 
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 Connecting to a LCD TV/ PDP 
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 Using the HDMI cable to connect a LCD TV/ PDP 

 
  

 Connecting to a computer 
 Use VGA cable to connect VGA IN connector on DC260 to the VGA 

OUT connector on the computer 

 

 Connecting to a computer through USB 

Connect to USB port. Then install the supplied Ladibug™ program. Please 
refer to DC260 User Manual 4.6 Installing application software. 

 
 
 

 Connecting to a computer through RS232 (RS232 Adapter is optional) 
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Speaker 

 Connecting to speaker 

 
<Remark>: Or connect to an additional amplifier before connecting 
to the speaker 
 

 Connecting to microphone 

 
 
 

Microphone 
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4.4 Start using the DC260 

Control Panel Remote Control 

  

 

 
 When using the remote control, aim at the receptor on the DC260, 

and press the power button. 
 Once DC260 is turned on, the LED on the control panel will flash a 

few times and stay lit. Please contact your distributor if the LED is not 
on. 

<Note> Once the password page is shown , please key in the 
password. If you forget it, please contact your distributor or the 
service center. 
 
 

4.5 Installing remote control holder 
  Insert the holder over the gooseneck of the camera and push it down. 
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4.6 Installing application software 
After installing the USB driver and application software, you can use the 
following functions: 

 Control the DC260. 
 Capture and record images. 
 Annotate the image, highlight important details and save it. 
 Support the full screen function. 

 
<Note>: Please refer to Ladibug™ software user manual for installation 
steps and software operation. 
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Chapter 5 DIP Switch Settings 
<Note> You have to reset the unit for setting to take affect. 
 

5.1 Connecting to a projector or monitor 
5.1.1 XGA 60Hz output (default values): 

 
5.1.2 SXGA 60 Hz output 

 
 

5.1.3 HDTV 720P 50Hz output 

 
 

5.1.4 HDTV 720P 60Hz output 
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5.2 Connecting to a TV 
5.2.1 NTSC: America, Taiwan, Panama, Philippines, Canada, 

Chile, Japan, Korea and Mexico 

  
 

5.2.2 PAL: Countries/regions not listed above. 

 

 
 

<Remark> VGA output is not supported once C-Video output has 
been enabled. 
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Chapter 6 Control Panel/Remote Control 
and Setting Menu 
6.1 Functions of control panel and remote control 

<Note> You are unable to use the [Menu] / [Rotate] / [Half Page] / [Source] / 
[Record] / [Capture] / [Delete] / [PBP] / [Slide Show] functions in C-Video 
mode. 
<Remark> The below functions are listed alphabetically. 
 

Name Function Operation 

 
Turn on and off the visual presenter. Remote control / 

Control panel  

 Move up, down, left or right to select the needed 
function. 

Remote control / 

Control panel 
AF Automatically adjust focal length on an object. 

 
Remote control / 

Camera Head 
Auto Tune Automatically adjust the image to have the best 

brightness and focusing performance. 
Remote control / 

Control panel 
BRT+/- Manually adjust the brightness of the image. Remote control  
Capture Capture the image to the SD card (priority) or 

internal memory. 
Remote control / 

Control panel 
Delete Delete the image stored in the SD card (priority) 

or internal memory. 
Remote control / 

Control panel 
Enter Enter/Activate functions. Remote control / 

Control panel  
Focus +/- Manually adjust focal length on an object. 

 
Remote control / 

Control panel 
Freeze Freeze the current image to temporarily stay on 

the screen. Press again to defreeze. 
Remote control / 

Control panel 
Half Page Turn on/turn off the Half Page function. Pressing 

[Half Page] once will display the upper half of the 
live image, while pressing [Half Page] twice will 
show the lower half of the live image. Press [Half 
Page] again to exit this function. 

Remote control / 

Control panel 
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Lamp Turn on / off the lamp. Remote control / 

Control panel 
M Scope Enter the microscope mode. Press again to 

return to the previous mode. 
Remote control  

Menu Activate the setting menu function/exit menu. Remote control / 

Control panel 
Mode Select general/slide/negative/microscope mode. Remote control 
PBP PBP (Picture by picture): Compare live images 

with captured image files. 
Remote control 

Photo/ Text Select photo, text or grayscale image mode. 
Refer to DC260 User Manual Chapter 7 
Descriptions of major functions 7.2 I would 
like to make text clearer and photos more 
colorful

Remote control 

Record Record motion images. Press [Record] to record 
images to SD card (priority) or internal memory; 
press[Record]again to stop recording. 

Remote control / 

Control panel 

Rotate Rotate the image by 0°/90°/180°/270°. Remote control / 

Control panel 
Slide Show Show the photos or videos stored in the SD card 

(priority) or internal memory in slide mode. 
Remote control  

Source Switch between different sources of signals:  
1. Live images (default) 
2. SD card (priority) or internal memory 
3. Computer 

Remote control / 

Control panel 

Zoom +/- Increase or decrease the image size. Remote control / 

Control panel 
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6.2 Setting Menu 

<Remark> Press [Menu] on the remote control or control panel to enter the 
setting menu; The bold underlined values in the following table are the 
defaults. 
1st Level 

Major 
Items 

2nd Level 
Minor Items 

3rd Level 
Adjustment 

values 
Descriptions 

Brightness 0~Max Use the left and right arrow 
keys to adjust the brightness. 

Mode Normal/Slide/ 
Film/Microscope 

Use the left and right arrow 
keys to select the image 
mode. 

Photo/Text Photo/Text/Gray 

Use the left and right arrow 
keys to select the image 
mode. 

Refer to DC260 User Manual 
Chapter 7 Descriptions of 
major functions 7.2 I would 
like to make text clearer and 
photos more colorful

PBP Enter

Press [Enter] to immediately 
activate photo comparison 
mode. Refer to DC260 User 
Manual Chapter 7 
Descriptions of major 
functions 7.15 I would like 
to compare images

Night Vision On/Off

Use the left and right arrow 
keys to select. The night 
vision mode suits with darker 
environment. 

Display 

Digital Zoom On/Off
Use the left and right arrow 
keys to turn digital zoom 
on/off. 
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Slide Show Enter

Press [Enter] to play the 
photos or videos stored in the 
SD card (priority) or internal 
memory. Refer to DC260 
User Manual Chapter 7 
Descriptions of major 
functions 7.14 I would like 
to play the slides

Slide Show 
Effect 

1. Off 

2. Shutter 

3. Right 

4. Down 

5. Side 

6. Open 

Use the left and right arrow 
keys to select the image 
switch mode. 

Delay 

1. 1 Sec 

2. 3 Sec 

3. 5 Sec 

4. 10 Sec 

5. Manual 

Use the left and right arrow 
keys to select the delay time. 

Select manual mode to switch 
images manually. 

Copy To SD Enter
Press [Enter] to immediately 
copy the data in visual 
presenter to the SD card. 

Delete All Yes/No

Use the left and right arrow 
keys to select, and then press 
[Enter] to confirm the deletion 
of photos. 

Delete the image stored in the 
SD card (priority) or internal 
memory. 

Storage 

Format Yes/No

Use the left and right arrow 
keys to select, and then press 
[Enter] to format the data 
stored in the SD card (priority) 
or internal memory. 
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Image Quality

1. High 

2. Medium 
3. Low 

Use the left and right arrow 
keys to select the image 
quality for the captured 
images and recorded videos. 

Capture 
1. Single
2. Continuous 
3. Disable 

Use the left and right arrow 
keys to select the video 
capture mode. 
(Single/Continuous/Disable) 

Capture Time

1. 1 hr
2. 2 hr 
3. 4 hr 
4. 8 hr 
5. 24 hr 

Use the left and right arrow 
keys to set the capture time. 
<Remark> It only works when 
the capture mode is set to 
[continuous]. 

Capture 
Interval 

1. 5 sec 
2. 10 sec 
3. 30 sec 
4. 1 min 
5. 2 min 
6. 5 min 

Use the left and right arrow 
keys to set the capture 
interval. <Remark> It only 
works when the capture mode 
is set to [continuous] 

Setting 

USB Transfer 
1. Camera 

2. Storage 
device 

Use the left and right arrow 
keys to select the USB 
transfer mode. 

1.Camera: connecting the 
DC260 to view live image; 
2.Storage device: connecting 
to the SD card (priority) or 
internal memory.  

Refer to DC260 User Manual 
Chapter 7 Descriptions of 
major functions 7.20 
Computer-related functions
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AE On/Off 

Regardless of outside 
environment, the machine will 
adjust the brightness to the 
optimal condition.  

Use the left and right arrow 
keys to select. 

AWB Enter

Regardless of outside light or 
color, the machine will adjust 
the color to the optimal 
condition. Press [Enter] to 
activate. 

Digital Zoom On/Off
Use the left and right arrow 
keys to turn digital zoom 
on/off. 

Noise 
Reduction On/Off

Use the left and right arrow 
keys to turn on/off the noise 
reduction function. Refer to 
DC260 User Manual Chapter 
7 Descriptions of major 
functions 7.17 I would like 
to reduce the image noise

 

Volume 0~Max Use the left and right arrow 
keys to adjust the volume. 
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Language 

1. English 

2. 繁体中文 

3. Deutsch 

4. Français 

5. Italiano 

6. Español 

7. Русский 

8. Nederlands 

9. Suomi 

10. Polski 

English 

Traditional Chinese 

German 

French 

Italian 

Spanish 

Russian 

Dutch 

Finnish 

Polish 

Use the left and right arrow 
keys in the language option to 
select the preferred language. 

Output Mode 

1. XGA 

2. SXGA 

3. UXGA 

4. 720P 

5. 1080P 

Using UXGA - set the DIP 
switch for XGA, select UXGA 
for OSD 
Using 1080P - set the DIP 
switch as 720P, select 1080p 
for OSD 
Based on different DIP switch 
settings, different output 
modes are provided. Refer to 
Chapter 5 DIP “Switch 
Settings” in the DC260 user 
manual. 

Advance 

Lock Down On/Off

Use the left and right arrow 
keys to turn the lock down 
function on and off. You can 
set the password when [On]is 
selected. Refer to DC260 
User Manual Chapter 7 
Descriptions of major 
functions 7.18 I would like 
to set / change the 
password
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Auto Erase On/Off

Use the left and right arrow 
keys to turn the auto erase 
function on and off. When 
[On] is selected, the saved 
images will automatically be 
deleted when the system is 
turned off. 

Refer to DC260 User Manual 
Chapter 7 Descriptions of 
major functions 7.11 I would 
like to automatically delete 
the captured images 
whenever it is turned off

Preset Load Yes/No

Read the value of the current 
image mode. 

Use the left and right arrow 
keys to select, and then press 
[Enter] to confirm. 

Preset Save Yes/No

Save the value of the current 
image mode. 

Use the left and right arrow 
keys to select, and then press 
[Enter] to confirm. 

 

Factory Reset Yes/No

Use the left and right arrow 
keys to select, and then 
immediately press [Enter] to 
activate the factory reset. 

Refer to DC260 User Manual 
Chapter 7 Descriptions of 
major functions 7.16 I 
would like to resume the 
factory default setting
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Chapter 7 Descriptions of major functions 
7.1 I would like to switch image sources 

Live image is the default of image source. Press [Source] on the remote 
control or control panel to change:  
1. Live images (default) 
2. SD card (priority) or internal memory  
3. Computer. 

 

7.2 I would like to make text clearer and photos more 
colorful 

Photo is the default. You can change setting via the remote control or 
control panel. 
Remote control:  
1. You can rotate between photo, text, and gray: 

 [Photo] (default): for viewing photos or text with photos and will make 
the photos more colorful. 

 [Text]: for viewing text files and will make the text clearer. 
 [Gray]: for viewing black and white photos and will make the 
grayscale differentiation more distinct. 

Control panel: 
1. Press [MENU] to enter the setting menu. 
2. Press [ ] or [ ] to select [Display]. 
3. Press [ ] to select [Photo/Text]. 
4. Press [ ] or [ ] to select [Photo/Text/Gray] (Refer to the description 

above). 
5. Press [MENU] to exit. 

 
7.3 I would like to zoom in /out of images 

1. Press [Zoom +] on the remote control or control panel to zoom in. 
2. Press [Zoom -] on the remote control or control panel to zoom out. 
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7.4 I would like to use the auto focus  

1. Press [AF] on the remote control. 
2. Press the AF button on the camera head of main unit. 
 

7.5 I would like to adjust the brightness 

Remote control:  
1. Press [BRT +] to make it brighter. 
2. Press [BRT -] to make it darker. 

Control panel: 
1. Press [MENU] to enter the setting menu. 
2. Press [ ] or [ ] to select [Display]. 
3. Press [ ] to select [Brightness]. 
4. Press [ ] or [ ] to adjust the value. 
 

7.6 I would like to turn on/ off the lamp 

1. The default of lamp is turn on. Press [Lamp] on the remote control or 
control panel to turn off. 

 
7.7 I would like to automatically adjust the image to have 

best brightness and focusing performance 

1. Press [Auto Tune] on the remote control or control panel. 
 
7.8 I would like to capture images 

7.8.1 Setting the quality of captured images 

1. Press [Menu] on the remote control or control panel to enter 
the setting menu. 

2. Press [ ] or [ ] to the [Storage] menu. 
3. Press [ ] to find [Image Quality]. 
4. Press [ ] or [ ] to select among [High/Medium/Low]. 
5. Press [Menu] to exit. 
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7.8.2 Setting continuous capture 

1. Press [Menu] on the remote control or control panel to enter 
the setting menu. 

2. Press [ ] or [ ] to the [Setting] menu. 
3. Press [ ] to find [Capture]. 
4. Press [ ] or [ ] to select [continuous]. 
5. Press [ ] to find [Capture Time]; Press [ ] or [ ] to select time 

settings. 
6. Press [ ] to find [Capture Interval]; Press [ ] or [ ] to select time 

settings. 
7. Press [Menu] to exit. 
 

7.8.3 Capturing and saving images 

1. Press [Capture] on the remote control or control panel. 
 

7.9 I would like to view captured images  

1. Press [Source] on the remote control or control panel to display 
thumbnails of all captured images. 

2. Press [ ] or [ ] or [ ] or [ ] to select the thumbnail you want you view. 
3. Press [Enter] for the full-screen display of the image. 
4. Press [ ] or [ ] to turn to the previous/next image. 
5. Press [Source] to exit. 

 

7.10 I would like to delete captured images  

1. Press [Source] on the remote control or control panel. 
2. Press [ ] or [ ] or [ ] or [ ] to select the thumbnail you want you 

delete. 
3. Pressing [Del] will open a [Delete File] window. 
4. Press [ ] or [ ] to select [Yes] (The default value is No). 
5. Press [Enter] to delete the selected photo. 
6. Press [Source] to exit. 
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7.11 I would like to automatically delete the captured 
images whenever it is turned off (Auto Erase) 

1. Press [Menu] on the remote control or control panel to enter the 
setting menu. 

2. Press [ ] or [ ] to access the [Advance] menu. 
3. Press [ ] or [ ] to [Auto Erase]. 
4. Press [ ] to select [On]. 
5. Press [ ] or [ ] to select [OK]. 
6. Press [Menu] to exit. 
7. It will automatically delete all captured photos when it is turned off. 
 

7.12 I would like to record and play videos 

7.12.1 Setting the image quality 
1. Press [Menu] on the remote control or control panel to enter the 

setting menu. 
2. Press [ ] or [ ] to the [Storage] menu. 
3. Press [ ] to find [Image Quality]. 
4. Press [ ] or [ ] to select among [High/Medium/Low]. 
5. Press [Menu] to exit. 

7.12.2 Recording videos 
1. Press [Record] on the remote control or control panel to start 

recording videos. 
2. Simultaneously record sounds with the built-in microphone of the 

control panel or the microphone connected to the MIC port.  

3. Press [Record] again to stop recording. 
[Note] The MIC port cannot be connected to an amplifier before 

connecting to the microphone. 

7.12.3 Playing videos 
1. Press [Source] on the remote control or control panel to display 

thumbnails of all video recorded. 
2. Press [ ] or [ ] or [ ] or [ ] to select the thumbnail you want you 

view. 

3. Press [Enter] for full-screen play 
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4. Press [ ] or [ ] to turn to the previous/next video. 
5. Press [Source] to exit. 
[Note] Only the MOV files recorded can be played and live sound 
output is not available; additional amplifier can be connected to 
the PHONE port. 

 
7.13 I would like to switch the view between the upper and 

lower half of the image (Half Page) 

1. Press [Half Page] on the remote control or control panel and the 
upper half of the live image will be displayed. 

2. When you press [Half Page] again, the lower half of the live image will 
be displayed. 

3. Press [Half Page] again to exit this function and return to the live image. 
<Notes> This function is not available under Microscope Mode. The 
Zoom in / out function is not available when this function is activated.  

 

7.14 I would like to play the slides (Slide Show) 

7.14.1 Setting the slide show effect  
1. Press [Menu] on the remote control or control panel to enter 

the setting menu. 
2. Press [ ] or [ ] to access the [Storage] menu. 
3. Press [ ] to find the [Slide Show Effect]. 
4. Press [ ] or [ ] to select image switch mode between [Off / 

Shutter / Right / Down / Side / Open]. 
5. Press [Menu] to exit. 

7.14.2 Setting delay time 
1. Press [Menu] on the remote control or control panel to enter 

the setting menu. 
2. Press [ ] or [ ] to access the [Storage] menu. 
3. Press [ ] to find the [Delay]. 
4. Press [ ] or [ ] to select image switch mode between [1 Sec / 3 

Sec / 5 Sec / 10 Sec / Manual]. 
5. Press [Menu] to exit. 
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7.14.3 Activating/Stopping the slide show 
<Notes>Images over 8 MB, cannot be played. Whilst playing, the 
[Rotate] function can be activated to rotate the images.  

Remote control: 
1. Press [Slide Show] to start playing. 
2. Press [Slide Show] again to stop playing. 

Control panel: 
1. Press [Menu] to enter the setting menu. 
2. Press [ ] or [ ] to access the [Storage] menu. 
3. Press [ ] to find [Slide Show] 
4. Press [Enter] to play. 
5. To stop playing, repeat steps 1 to 4. 

 
7.15 I would like to compare images (Compare live images 

with captured images) (PBP, Picture by Picture) 

This function will compare and contrast a live image with a captured image. 

 
C2C1 

 Captured Image   Live Image 

C3 C4

C6C5 C7

 
 
 
 
 
 
 

 

Remote control: 
1. Press [PBP] to enter the PBP (Picture by Picture) photo selection 

screen. 
2. Press [ ] or [ ] or [ ] or [ ] to select the files to be compared. 
3. Press [Enter] to activate the image comparison. 
4. Press [ ] or [ ] to move the images (captured images only) 

leftward/rightward. 
5. Press [PBP] to exit. 
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Control panel: 
1. Press [Menu] to enter the setting menu. 
2. Press [ ] or [ ] to access the [Display] menu. 
3. Press [ ]to find[PBP] 
4. Press [Enter] to enter the PBP (Picture by Picture) photo selection 

screen. 
5. Press [ ] or [ ] or [ ] or [ ] to select the files to be compared. 
6. Press [Enter] to activate the image comparison. 
7. Press [ ] or [ ] to move the images (captured images only) 

leftward/rightward. 
8. Press [Menu] again to return to image thumbnails. 
9. Press [Source] to exit. 

 
7.16 I would like to resume the factory default setting 

(Factory Reset) 

1. Press[Menu]on the remote control or control panel to enter the 
setting menu 

2. Press [ ] or [ ] to access the [Advance] menu. 
3. Press [ ] to select [Factory Reset]. 
4. Press [ ] or [ ] to select [Yes]. 
5. Press [Enter] to activate. 

 

7.17 I would like to reduce the image noise (Noise 
Reduction) 

This function enables visual presenter to automatically clear image noise. 
The noise is especially obvious when Visual presenter is connected to a 
DLP projector. You can use this function to improve the image quality. 
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1. Press [Menu] on the remote control or control panel to enter the 
setting menu. 

2. Press [ ] or [ ] to the [Setting]. 
3. Press [ ] to find [Noise Reduction]. 
4. Press [ ] or [ ] to select [On]. 

7.18 I would like to set / change the password (Lock Down)  

7.18.1 Setting the password 
1. Press [Menu] on the control panel to enter the setting menu. 
2. Press [ ] or [ ] to the [Advance] menu. 
3. Press [ ] to [Lock Down]. 
4. Press [ ] or [ ] to select [On]. 
5. The screen will be displayed, as shown below. 
 
 
 
 

Key in Password 

＊＊

6. Key in the password 
 Press the keys on the control panel. All keys can be used as part of 

the password except the [Power] and [Enter] keys. The maximum 
number of characters is 2. For example, you can press [Source] + 
[Menu] as the password. 

 <Remark>The screen will show * while you enter the password. 
Ensure that you remember the order in which the keys are 
entered. 

7. After completing the password, press [Enter].  
8. The confirmation screen will be displayed, as shown below. Enter the 

password again. 
 
 
 
 

Confirm password 

9. After you enter the password, press [Enter].  
 If the password is entered correctly, setup is completed. If the 

password is incorrect, an error message is displayed and please 
follows the screen instructions. 
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7.18.2 Changing the password 
1. Press [Menu] on the control panel to enter the setting menu. 
2. Press [ ] or [ ] to the [Advance] menu. 
3. Press [ ] to [Lock Down] 
4. Press [ ] or [ ] to select [Off] and deactivate the password 

setting function. 
5. Press [ ] or [ ] to select [On] and reactivate the password 

setting function. Refer to Steps 5-8 in DC260 User Manual 
Chapter 7 Descriptions of major functions 7.18.1 Setting 
the password for operational steps. 

 
7.19 Using a SD card 

7.19.1 Deactivate the write protect function (SD Lock) 
If the write protect function of the SD card is activated, you will not be able 
to use the Capture function, although you can still read the files in it. 
Adjust the Lock of the SD card to deactivate the write protect function. 

 

 

 

 

 

7.19.2 Inserting a SD card 
7.19.2.1 The screen will display [Copy to SD card] and ask if you 

would like to copy the files saved in the DC260 to a SD card. 
 Press [ ] or [ ] on the control panel to select. 

 
 
 
 

 

Copy to SD Card

YES NO 

7.19.2.2 The screen will display as follow, once you insert an 
unformatted SD card. 

 Press [ ] or [ ] on the control panel to select. 
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Format SD Card

YES NO 
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<Note> The data previously saved on the SD card will be 
erased when it is formatting. 
 

7.19.3 Ejecting a SD card 
<Note> Turn the power off before ejecting the SD card to 
avoid damaging the SD card. 

 

 

7.20 Computer-related functions  

Ensure that the USB cable is connected and the drivers are installed 
before using the computer-related functions. Refer to DC260 User Manual 
Chapter 4 Installation and Connections 4.3 Connecting Devices and 
4.6 Installing application software. 

7.20.1 I would like to insert a photo in MS-Paint 

1. Click File> From Scanner or Camera in MS-Paint shown as the 

bottom left figure. 

 

2. Click [Get Picture] will capture the photos of live images and insert 

the files in use shown as top right figure. 
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7.20.2 I would like to insert a photo in MS-Word 

1. Click Insert > Image > From Scanner or Camera in MS-Word. 

 

2. Select [Visual Presenter V2] and click [Custom Insert]. 

 
 

3. Click [Get Picture]. It will capture the photo of live image. 
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7.20.3 I would like to change the setting of DC260 then capture a 
photo in MS-Word 

1. Click Insert > Image > From Scanner or Camera in MS-Word. 

 

2. Select [Visual Presenter V2 TWAIN] and click [Custom Insert]. 

3. A window showing a live image (see below) will be displayed. 
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4. Press [Setting] to control the DC260 via the Camera Settings 
interface. The operating procedure is the same with the remote 
control and control panel of the DC260. Refer to DC260 User 
Manual Chapter 6 Control Panel / Remote Control and Setting 
Menu. 

5. Press [Setting] to capture images in MS-Word. 

6. Press [Cancel] to exit. 

 

7.20.4 I would like to set the DC260 as a webcam for Skype 

The DC260 can be used as a webcam for teleconferencing software 
such as Skype and MSN. The following instructions use Skype as an 
example. 
1. Open Skype and enter Tools > Options…. 
2. Select [Video Settings] > [webcam] > [Visual Presenter V2] and check 

Start my video automatically when I am in a call, as shown below. 
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3. Start calling your contact. When both sides are connected, Skype will 
display the video screen. 

 
7.20.5 I would like to set the DC260 as a PC Camera 

1. Press [Menu] on the control panel to enter the setting menu. 
2. Press [ ] or [ ] to the [Setting] menu. 
3. Press [ ] to find [USB Transfer]. 
4. Press [ ] or [ ] to select [Camera]. 
5. A window will be displayed, showing the [Visual Presenter V2], as 

shown below 

 
6. Click the [Visual Presenter V2]. 
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7.20.6 I would like to set the DC260 as a Removable Disc 

1. Press [Menu] on the control panel to enter the setting menu. 
2. Press [ ] or [ ] to the [Setting] menu. 
3. Press [ ] to find [USB Transfer]. 
4. Press [ ] or [ ] to select [Storage device]. 
5. Press [Menu] to exit. 
6. A Removable Disc will be displayed. 
<Remark> The Removable Disc will select SD card if a SD card has 
been inserted, but if a SD card has not been inserted, the Removable 
Disc is internal memory.  

 
 
<Note> Doing this will disable the Capture function. Suggest you 
return it to [Camera] mode after using this function. Please follow 
the steps below.  
1. Press [Menu] on the control panel to enter the setting menu. 
2. Press [ ] or [ ] to the [Setting] menu. 
3. Press [ ] to find [USB Transfer]. 
4. Press [ ] or [ ] to select [Camera]. 
5. Press [Menu] to exit. 
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7.20.7 I would like to connect   Interactive Whiteboard

1. System diagram 
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 PC 

USB Cable USB Cable 

Interactive Whiteboard 
Visual Presenter 

 

2. Using StarBoard 

2.1 Install LuLulizer and execute “LuLulizer.exe” 

<Note> Please download LuLulizer from the website 
(www.lumens.com.tw/goto.htm) 
2.2 Press [StarBoard] / [LULU] 
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2.3 Display the live image. 

 
 

2.4 Press [StarBoard] / [Mode] / [TWAIN] 
Please refer to the operations of 7.20.2 I would like to insert a 
photo in MS-Word and 7.20.3 I would like to change the 
setting of DC260 then capture a photo in MS-Word

 
3. Using SmartBoard  

3.1 Press [Insert] / [Picture From Scanner] 

 
 

3.2 Please refer to the operations of 7.20.2 I would like to insert a 
photo in MS-Word and 7.20.3 I would like to change the 
setting of DC260 then capture a photo in MS-Word 
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Chapter 8 Connecting to Microscope 
1. Mount the microscope adaptor onto the microscope.  
2. The lens of DC260 connects with the microscope adaptor. 

 
3. Select the[Microscope]Mode 

3.1. Press [M Scope]on the remote control (suggestion). 
3.2. Control panel 

3.2.1. Press [MENU] to enter the setting menu.  
3.2.2. Press [ ] or [ ] to select [Display]. 
3.2.3. Press [ ] to select [Mode]. 
3.2.4. Press [ ] or [ ] to select [Microscope]. 

4. If the image is not clear. 
4.1. Please adjust the focus of microscope. 
4.2. Press the AF button on the camera head of main unit to activate the 

auto focus. 
5. Digital Zoom 

5.1. Press [MENU] to enter the setting menu. 
5.2. Press [ ] or [ ] to select [Display]. 
5.3. Press [ ] to select [Digital Zoom]. 
5.4. Press [ ] or [ ] to select [On]. 
5.5. Press [Zoom +]/[Zoom -] on the remote control and control panel 

 
<Note> In microscope mode all functions are available except for the 
[Zoom +] / [Zoom -] / [Half Page] functions on the remote control and 
control panel. Please reset to normal mode after using the microscope, 
otherwise, you are unable to use zoom in/out function. 

1. Press [MENU] on the control panel to enter the setting menu.  
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2. Press [ ] or [ ] to select [Display]. 
3. Press [ ] to select [Mode]. 
4. Press [ ] or [ ] to select [Normal]. 
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Chapter 9 Troubleshooting 
This chapter describes problems you may encounter while using DC260. If you 
have questions, please refer to related chapters and follow all the suggested 
solutions. If the problem still occurred, please contact our distributors or service 
center. 

No. Issues Solutions 
1 Boot without 

power 
Make sure you have plugged in the power cord. 

2 No image output 
from the DC260 

1. Check the power.  
2. Check the connection, Refer to DC260 User 

Manual Chapter 4 Installation and 
Connections 4.3 Connecting Devices 

3. Check the [Source], refer to DC260 User Manual 
Chapter 7 Descriptions of major functions 7.1 
I would like to switch image sources 

4. Check the settings for the source of the 
projector. For the appropriate input selection of 
the projector, refer to the projectors user manual  

5. Check if DIP Switch is properly set. Refer to 
DC260 User Manual Chapter 5 DIP Switch 
Settings for related settings. 

3 Unable to focus  Probably the document is too close. Press [zoom -] 
on the remote control or control panel. Or pull 
away the distance between document and lens, then 
press [AF]. 

4 The image is 
incomplete 

Check the Auto Image setting of your 
projector. Please refer to the user manual of the 
projector. 

5 Forget the 
password for 
turning on 

Please contact your distributor or the service center. 

6 Visual Presenter 
V2, Ladibug™ or 
other application 
cannot be 
executed 
simultaneously. 

Visual Presenter V2, Ladibug™ and other 
applications cannot be executed simultaneously. 
Only one application can be executed at a 
time. Please close the currently running applications 
and then execute the application to be used. 
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